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are set forth in the express warranty statements accompanying such products and services. Nothing herein
should be construed as constituting an additional warranty. Micro Focus shall not be liable for technical or
editorial errors or omissions contained herein. The information contained herein is subject to change without
notice.

Documentation updates
The title page of this document contains the following identifying information:
l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

You can check for more recent versions of a document through the MySupport portal. Many areas of the
portal, including the one for documentation, require you to sign in with a Software Passport. If you need a
Passport, you can create one when prompted to sign in.

Additionally, if you subscribe to the appropriate product support service, you will receive new or updated
editions of documentation. Contact your Micro Focus sales representative for details.

Support
Visit the MySupport portal to access contact information and details about the products, services, and
support that Micro Focus offers.

This portal also provides customer self-solve capabilities. It gives you a fast and efficient way to access
interactive technical support tools needed to manage your business. As a valued support customer, you can
benefit by using the MySupport portal to:

l Search for knowledge documents of interest
l Access product documentation
l View software vulnerability alerts
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l Download software patches
l Manage software licenses, downloads, and support contracts
l Submit and track service requests
l Contact customer support
l View information about all services that Support offers

Many areas of the portal require you to sign in with a Software Passport. If you need a Passport, you can
create one when prompted to sign in. To learn about the different access levels the portal uses, see the
Access Levels descriptions.
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About this document
Structured DataManager’s integration kit for PeopleSoft modules provides a powerful, pre-built archive
solution for PeopleSoft data. This guide covers:

l meeting the installation prerequisites for PeopleSoft

l installing Structured DataManager

l deploying PeopleSoft business flows to your runtime system

l running the business flows to archive your PeopleSoft data

Intended audience
This guide is intended for:

l Administrators/operators who need to run PeopleSoft modules to archive data from PeopleSoft
applications

l Administrators/operators who need to install the Structured DataManager, deploy and redeploy
business flows, and run the business flows

Prerequisites
Prerequisites for installing this product include:

l Knowledge of operating systems

l Database knowledge

l Application knowledge

Related documentation
l Structured DataManager API ReferenceGuide

Provides information about the Groovy script API files for Structured DataManager.

l Structured DataManager Concepts Guide

Explains themajor concepts of database archiving in general and Structured DataManager in
particular.

l Structured DataManager Installation Guide

Explains how to use the Installer to install the product.

PeopleSoft Modules Installation and Deployment Guide
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l Structured DataManager Tutorial

Provides step-by-step instructions to build a sample archivingmodule, deploy it, run it, and
troubleshoot errors.

l Structured DataManagerDevelopers Guide

Explains how to use the Designer component to design, build, test, and deploy your archiving
projects.

l Structured DataManager RuntimeGuide

Explains how to use theWebConsole component to run, monitor, and administer business flows
that move data to and from the database.

l Structured DataManager Troubleshooting Guide

Explains how to diagnose and resolve errors, and provides a list of common errors and solutions.

l Structured DataManager UpgradeGuide

Explains how to upgrade the product and upgrade the archive schema generated by earlier versions
of the product.

l Structured DataManager Release Notes

Lists any items of importance that were not captured in the regular documentation.

l Structured DataManager PeopleSoft Modules Installation and Deployment Guide

Explains how to install the PeopleSoft integration kit.

l Structured DataManager Oracle E-Business Suite Modules Installation and Deployment Guide

Explains how to install the Oracle E-Business Suite integration kit.

PeopleSoft Modules Installation and Deployment Guide
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Chapter 1: Prerequisites
Before installing the Structured DataManager, you should ensure that you have the latest
documentation, and that you understand the overall installation process.

l Before you begin, below

l Obtain the latest Structured DataManager documentation, below

Before you begin
Before you begin archiving data using the Structured DataManager, you should:

1. Review theStructured DataManager Concepts Guide to become familiar with the software and
how you plan to use it.

2. Install the Structured DataManager according to the instructions in theStructured DataManager
Installation Guide.

3. Use theStructured DataManager Developer’s Guide to design and develop or customize your
archive solution.

Obtain the latest Structured Data Manager
documentation
The latest version of the Structured DataManager documentation can always be found on theMicro
Focus Software Product Manuals web page. You should check for documentation updates before
installing.

The latest documentation for Structured DataManager can be found onMicro Focus Software Support
Online

NOTE:  This documentation is written to the latest patch version. If you have not installed the
latest patch, theremay be items in this documentation that do not apply to your environment.
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Chapter 2: Structured Data Manager
requirements
Structured DataManager PeopleSoft integration kits have the following requirements for installation.
Requirements vary depending how you plan to archive your data.

l Operating system and server requirements, below

l Software requirements, below

l Oracle database requirements, below

l Custom target schema, on page 11

Related information

Structured DataManager Concepts Guide

Structured DataManager Installation Guide

Structured DataManager RuntimeGuide

Structured DataManager Developer’s Guide

Operating system and server requirements
The operating system and server requirements are documented in the
Structured DataManager Installation Guide.

Ensure that youmeet the operating system and server requirements before installing Structured Data
Manager.

Software requirements

Structured Data Manager requirements

Before installing your PeopleSoft modules, ensure that you are running
Structured DataManager 7.5 with the latest patches.

Oracle database requirements
Database to database archiving with PeopleSoft requires the following:

l a repository to store archivingmetadata

l a source database from which to archive eligible data (also referred to as the active database)
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l for distributed archive only, a target database in which to store archived data (also referred to as the
archive database)

The repository, source and target databases require one of the following Oracle database versions:

l Oracle 12c( 12.1.0.2 for Linux, 12.1.0.1 forWindows )

l Oracle 11g (11.2.0.3.0 and above)

l Oracle 10gRelease 2 (10.2.0.4 and above)

l Oracle 9i Release 2 (9.2.0.8 and above)

An administrator account with the following privileges is required:

l Create Database

l Create Login

l Create User

l Grant permissions to non-owned tables

This document refers to this account as the system account, but it can have any name you assign to it.

NOTE:  The source database, repository, and target databasemust use the same character
encoding. If the character encoding is not the same, a warning is displayed in the installation
summary.

Source database preparation for Oracle
1. Ensure there is 1.5 GB of available disk space to create tablespaces.

TIP:  When you calculate the space requirements, you need to consider how much space
you need for rollback segments and temporary segments.

2. Create the following data and index tablespaces.

Tablespace Size Usage

INTF_DATA 20GB Holds table data for the interface schema.

INTF_TEMP 20GB Holds temporary data for the interface schema.

ARC_DATA 10GB Holds table data for the archive access build schema.

ARC_TEMP 10GB Holds temporary data for the archive access build schema.

For example, use syntax similar to the following:

create tablespace OBT_DATA datafile ‘<path>/OBT_DATA.dbf’ size 1GB autoextend on;

where <path> is the directory location where you want to save the tablespace datafile.

The tablespaces are selected during installation.

PeopleSoft Modules Installation and Deployment Guide
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See also:

l Product setup and business flow deployment, on page 16

l Deploy business flows, on page 19

3. If you are using the distributed archive configuration option, add an entry in tnsnames.ora for the
target database.

4. Add the following entries to the source database init.ora file:

l _PUSH_JOIN_UNION_VIEW = TRUE

l COMPATIBLE = <current_database_release>

Target database preparation for Oracle
The target or archive database is required for the distributed archive configuration option.

Ensure the procedures in this section are complete before you run theWebConsole or Designer.

1. Create a target database with the following configuration:

l Default LARGE init.ora parameters

The init.ora parameter values depend upon the size of the installation, and are recommended by Micro
Focus service representatives.

l 8 K for the db_block_size parameter, or the same as the source database

l NLS_LANGUAGE character set must be the same as the source database

2. Create or expand the following tablespaces:

The tablespaces are selected during installation.

Tablespace Size Usage

HIST_DATA 250GB Holds table data for the history schema.

HIST_TEMP 50GB Holds temporary data for the history schema.

HIST_INDEX 250GB Holds temporary data for the history schema.

RELOC_DATA 20GB For distributed archive only, holds table data for the
relocation schema.

RELOC_TEMP 2GB For distributed archive only, holds temporary data for the
relocation schema.

AA_DATA 1GB Holds table data for the archive access schema.

AA_TEMP 10GB Holds temporary data for the archive access schema.

See also:

PeopleSoft Modules Installation and Deployment Guide
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l Product setup and business flow deployment, on page 16

l Deploy business flows, on page 19

3. Add an entry in tnsnames.ora for the source database.

4. Ensure the db_domain of the target database is the same as the db_domain of the source
database.

If the db_domain is different, set global_names to FALSE.

Repository preparation
Structured DataManager requires a repository to store archivingmetadata. The repository should
reside on an existing database where backups are regularly performed.

1. Identify a persistent databasemeeting the following requirements:

l Database version—the database you choose for your repository must have the same
database version as the source database.

l Available tablespace—4GB

l Available diskspace—1GB

2. Create the following tablespaces:

Tablespace Size Usage

REP_DATA 800MB Holds table data for the repository schema.

REP_TEMP 800MB Holds temporary data for the repository schema.

The tablespaces are selected during installation.

3. When you set up database to database archiving, select the tablespaces that you created.

Custom target schema
Database to database archiving requires a target schema for Oracle. The target schema is created
automatically when you deploy a business flow.

DEPRECATED:  Use theWebConsole to create the target schema or database.

The default target schema is created using the naming convention <source_database_name>_HIST,
where <source_database_name> is the name of your source database. Creating your own target
schema enables you to select a name that matches your existing naming conventions.

When you create your own target schema, you can also choose to create your own target tables. This
enables you to use tables with partitions in your database to database archiving environment.

If you create your own target schema, youmust also register the ownermappings.

PeopleSoft Modules Installation and Deployment Guide
Chapter 2: Structured DataManager requirements
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If you choose to create your own target schema and target tables, perform the steps in the following
sections:

l Create the target schema or database, below

l Create the target tables, below

Create the target schema or database

1. Create a schema on the target database for each schema on the source database.

2. Ensure that the schema or database owner has the following permissions:

l CREATE SESSION

l CREATE TABLE

l CREATE DATABASE LINK

l SELECT ANY DICTIONARY

3. Run the ownermapping API to ensure that the target schema is updated before you deploy any
business flows.

See “OwnerMapping JavaScript API” in theStructured DataManager API ReferenceGuide.

Create the target tables

After you have created your own target schema, you can use theWebConsole to create the target
tables.

See theStructured DataManager RuntimeGuide.

To use the Web Console to create the target tables

1. If theWebConsole is not running, select Start > Programs > Structured Data Manager > Start
Web Console.

Or, start theWebConsole from the command line using the appropriate command, where <install_
directory> is the location where you installed the software:

For Type

UNIX GUI ./<install_directory>/obt/bin/webConsole.sh

DOS <install_directory>/obt/bin/webConsole.bat

The default port for theWebConsole is 8080. Since theWebConsole runs on Tomcat, you can change
this port in the server.xml file in <install_dir>/obt/webconsole/apache-tomcat/conf. See the
Structured DataManager RuntimeGuide for more information.

2. Launch theWeb browser.

If you choose to create the tables manually, youmust ensure each table contains the following
columns:

PeopleSoft Modules Installation and Deployment Guide
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Column name Data type Value

OBT_SAVED_ROWID ROWID not null

OBT_ROW_SEQ NUMBER not null

OBT_WF_RUN_ID VARCHAR2(128) not null

l Ensure the new table names matchmanaged table names in the source database or schema.

l Ensure all column names, data types, lengths, and null/not null properties for themanaged
tables are the same.

l If you choose to create the target driving table, it must also contain the following column:

Column name Data type Value

OBT_TIMESTAMP DATE SYSDATE

PeopleSoft Modules Installation and Deployment Guide
Chapter 2: Structured DataManager requirements
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Chapter 3: Installation
The Structured DataManager installation installs theWebConsole and Designer.

l Structured DataManager installation overview , below

l Install Structured DataManager, on the next page

See also

Structured DataManager Installation Guide

Structured DataManager RuntimeGuide

Structured Data Manager installation overview
Before you can use theMicro Focus Databases Archiving software to archive your data, you need to
install the software, set up the database archiving components, and deploy the business flows that
archive your data.

Installing the Structured DataManager consists of the followingmain steps:

1. Review the introductory chapters in theStructured DataManager Developer’s Guide and the
Structured DataManager RuntimeGuide to choose the archive solution that is right for you.

2. Ensure that the all the requirements for your servers, databases, and archiving solution have been
met.

See also:

l Operating system and server requirements, on page 8

l Software requirements, on page 8

l Oracle database requirements, on page 8

l Repository preparation, on page 11

3. Install Structured DataManager. Structured DataManager installation installs theWebConsole
and Designer.

See Install Structured DataManager, on the next page.

4. Start theWebConsole to create the repository and set up database to database archiving.

See also Product setup and business flow deployment, on page 16.

5. Run the addObjectOwnerPair.groovy API to create the correct names for your archive access
schema.

See also Set the archive access schema name, on page 16.
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6. Obtain the necessary project files for your PeopleSoft modules.

See also Import PeopleSoft integration kits, on page 18.

7. Customize your PeopleSoft project.

8. Deploy the business flows you have created. You can deploy the business flows and cartridges
using Designer, or generate them to be deployed using theWebConsole.

See also Deploy business flows, on page 19.

Install Structured Data Manager
Before deploying the business flows for your PeopleSoft modules, youmust install Structured Data
Manager and set up theWebConsole:

l Install as per the instructions inStructured DataManager Installation Guide

l Set up theWebConsole as per the instructions inStructured DataManager RuntimeGuide.

Post installation task

After you set up the Web Console, do the following

1. Start theWebConsole.

2. Click Business Flow Management.

3. Click Parameters from themenu at the top of the page.

4. ChooseDatabase to Database.

5. Under theCore Parameters, set theUse Data Movement Key to move data to true.

6. Click Apply.

PeopleSoft Modules Installation and Deployment Guide
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Chapter 4: Product setup and business
flow deployment
Use theWebConsole to configure database to database archiving and to deploy business flows
against a database for execution.

To use the command line, see theStructured DataManager Installation Guide.

l Set the archive access schema name, below

l Run reports from the archive access account, on the next page

l Import PeopleSoft integration kits, on page 18

l Deploy business flows, on page 19

l Create a new access profile in PeopleTools 8.4x and above, on page 22

See also

l Structured DataManager Installation Guide

l Structured DataManager RuntimeGuide

NOTE:  If you are running on AIX, you need to perform some additional steps because theWeb
Console requires the Java 6 32-bit JRE. For detailed information, refer to theStructured Data
Manager RuntimeGuide.

Set the archive access schema name
Before deploying any PeopleSoft cartridges or business flows, you need to run the
addObjectOwnerPair.groovy API to create the archive access schema name.

By default, the archive access schema is created using the naming convention <source_database_
name>_AA, where <source_database_name> is the name of your source database. For example, if the
default PeopleSoft schema is SYSADM, then the archive access schema is automatically created as
SYSADM_AA.

Because the PeopleSoft Access ID is limited to 8 characters, and the Access ID is used for archive
access, you need to create a name to be used for the archive access schema before deploying a
cartridge or business flow. When cartridges and business flows are deployed, the name you set here is
used instead of the default naming convention. For example, for the SYSADM schema, you could
create the name as SYSADMAA, whichmeets the character limitation.

The ownermappingmust not be already defined in the OLTP database, and the archive access owner
namemust not be in use.

1. Navigate to the following directory:

<install_directory>/obt/bin

where <install_directory> is the location where you installed the software.
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2. Run the addObjectOwnerPair.groovy API using the appropriate syntax:

For Syntax

UNIX ./launch_groovyscript.sh -e DefaultEnvironment -f
../scripts/addObjectOwnerPair.groovy <oltpCatalog>
<oltpSchema> <aaCatalog> <aaSchema> [<transparencyLayer>]

WINDOWS launch_groovyscript.bat -e DefaultEnvironment -f
..\scripts\addObjectOwnerPair.groovy <oltpCatalog>
<oltpSchema> <aaCatalog> <aaSchema> [<transparencyLayer>]

Where Is

oltpCatalog Source catalog for SQL Server.

For Oracle, this is always " " (empty string).

oltpSchema Source schema for Oracle.

Source user for SQL Server.

aaCatalog Archive access catalog for SQL Server.

For Oracle, this is always " " (empty string).

aaSchema The name you want to use for your archive access schema. The
archive access schema name is limited to 8 characters because of the
PeopleSoft Access ID requirement.

Archive access schema for Oracle.

Archive access user for SQL Server.

transparencyLayer Name of the transparency layer (optional).

Example

launch_groovyscript.bat -e DefaultEnvironment -f
..\scripts\addObjectOwnerPair.groovy "" pshrdmo "" SYSADMAA

3. Enter the encryption key at the prompt.

SeeStructured DataManager API ReferenceGuide

Run reports from the archive access account
The PeopleSoft archive access layer is created as a read-only view of the database to prevent any
inadvertent change to archived data. The PeopleSoft Process Scheduler, however, needs write access

PeopleSoft Modules Installation and Deployment Guide
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to certain PeopleTools tables while running reports. Therefore, running reports through the archive
access layer requires write access to these tables.

As an example, in PeopleTools 8.50, privileges need to be explicitly given to the following tables:

grant update,insert on ps_prcsruncntl to SYSADMAA;
grant update,insert on psprcsrqst to SYSADMAA;
grant update on ps_prcssystem to SYSADMAA;
grant insert,update on psserverstat to SYSADMAA;
grant update on pslock to SYSADMAA;
grant update,insert,delete on psprcsruncntl to SYSADMAA;
grant update,insert,delete on psprcsruncdel to SYSADMAA;
grant update,insert on psprcslock to SYSADMAA;
grant update,insert on psprcsrqstxfer to SYSADMAA;
grant update,insert on ps_message_log to SYSADMAA;
grant update,insert on ps_message_logparm to SYSADMAA;
grant update,insert on <RunCntlTables> to SYSADMAA;
where <RunCntlTables> are the run control tables for the reports you plan to run
from the archive access account.

Import PeopleSoft integration kits
The PeopleSoft integration kits are delivered on a CD or as .zip files you can download. You should
import the kits into Designer for review ormodification.

1. If theWebConsole is not running, select Start > Programs > Structured Data Manager > Start
Web Console.

Or, start theWebConsole from the command line using the appropriate command, where <install_
directory> is the location where you installed the software:

For Type

UNIX GUI ./<install_directory>/obt/bin/webConsole.sh

WINDOWS <install_directory>/obt/bin/webConsole.bat

2. Launch theWeb browser.

TheWebConsole opens.

3. Open the .zip file containing the PeopleSoft kits.

The zip file contains individual .zip files for each PeopleSoft module. For example, xxx.sdm_7.60_
<Bld_no>.zip (where Bld_no is the build number and rev_no is the revision number) contains the files
for the PeopleSoft Payroll module.

4. Extract the individual .zip files for the desired PeopleSoft modules from themain zip file.

5. Extract the files from the individual module .zip files into a directory that is accessible from the
machine where you plan to run Structured DataManager.

Each PeopleSoft module zip file contains the following subdirectories:

PeopleSoft Modules Installation and Deployment Guide
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Directory Contents

sources contains the project file (.hdp) that you can open with Designer.

deployables contains the deployment files (.busflow) that you can directly deploy from the
WebConsole.

utils contains additional files that typically do not need to be accessed.

6. Launch Designer.

7. Create a new project.

The project requires a connection to the Oracle database that contains the PeopleSoft tables you want
to archive.

8. Import the PeopleSoft project.

a. Select File > Import.

b. ChooseExisting Designer Project from the list of values.

c. Click Next.

d. Browse to the location of the PeopleSoft project.

The PeopleSoft project is stored as a .hdp file.

At this point you can review ormodify the projects in Designer. After review ormodification, you
can deploy the PeopleSoft business flows from Designer or theWebConsole.

Related information

l Structured DataManager RuntimeGuide

l Structured DataManager Developer’s Guide

Deploy business flows
You can deploy business flows from Designer or theWebConsole.

In Designer, you can deploy business flows that you created or modified from your PeopleSoft project,
or you can generate business flows to be deployed later using theWebConsole.

Generated business flows are .zip files with a .busflow extension. Generated business flows that have
not beenmodified are located in the deployables directory extracted in Import PeopleSoft integration
kits, on the previous page.

You can deploy multiple business flows at the same time.

See also

l Structured DataManager RuntimeGuide

l Structured DataManager Developer’s Guide

PeopleSoft Modules Installation and Deployment Guide
Chapter 4: Product setup and business flow deployment

Structured DataManager (2019.09) Page 19 of 42



TIP:  You can use advancedmode or express mode to deploy business flows. Advanced allows
you to set your Oracle tablespace sizes. With express mode, the tablespace sizes are set
automatically.

Create database to database archive access transparency
Data transparency refers to the ability of users to see archived data as though it were still in the active
database. If you implement data transparency, both active and archive data can be accessed through
the current user interface. All data relationships necessary tomaintain data and application integrity are
retained.

After archiving your data, you can run the Create Archive Access job to enable transparency, which
allows your users to view your archived data directly from the application.

NOTE:  Contact your Micro Focus sales representative for information about licensing
requirements for data transparency.

The Create Archive Access job creates or recreates objects within the Archive Access schemas or
databases. The running time of the script depends on the number of cartridges included in your
business flows, the number of managed tables, and the number of views, stored procedures, and
packages that are dependent on those objects. To customize this job, see theStructured Data
Manager API ReferenceGuide.

You should run the Create Archive Access job whenever any of the following occur:

l Changes aremade to tables, views, stored procedures, or packages in the active database.

l New cartridges are installed.

l Cartridges are upgraded.

l New patches are installed on the active database.

l Any of the ArchiveAccessConfiguration groovy scripts are run.

Structured DataManagerAPI ReferenceGuide

NOTE:  The Archive Access schema is unstable while the Create Archive Access job is
running. To avoid errors, wait until after the job has completed successfully before accessing
the archive.

1. Start theWebConsole, if it is not already started.

2. Ensure that you have deployed the business flows.

3. Confirm that the configurationmode parameter is properly set by navigating to the Parameters -
Database to Database page.

PeopleSoft Modules Installation and Deployment Guide
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4. Click Launch in themenu at the top of the page.

5. Click Create Archive Access in the left navigation pane. The job launch page for the Create
Archive Access job displays.

6. Click Run to run the job immediately, orSchedule to schedule the job for a later time.

7. Click Confirm to confirm the job. When the job completes successfully, you should be able to
access the access the archived data from your application.

Test accessing some of the archived data from your application to ensure that the archive access is
working.

PeopleSoft Modules Installation and Deployment Guide
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Create a new access profile in PeopleTools 8.4x and
above

To create a new access profile, edit, or delete existing profiles in PeopleTools, use the
Access Profiles screen.

1. Sign on to the Application Designer.

2. Click OK.

3. In the next screen, select Tools > Miscellaneous Objects > Access Profiles.

The Access Profiles screen displays.

PeopleSoft Modules Installation and Deployment Guide
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4. Click New.

The Add Access Profile screen displays.

5. Enter the following information:

Field Description

Symbolic ID Enter the Symbolic ID you want to assign to the new access profile. For
example, SYSADMAA.

Access Profile ID Enter the name of the Archive Access schema that was created at
installation. This valuemust be SYSADMAA.

Access Password Enter a password for the access profile.

Confirm Password Enter the password again.

6. Click OK to save the new user profile.

7. Click Close to exit the Access Profiles screen.

PeopleSoft Modules Installation and Deployment Guide
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Grant archive access to user accounts in PeopleTools 8.4x
After creating the access profile, youmust duplicate an existing user account and grant access to that
new user.

NOTE:  Repeat these steps for each user who requires access.

1. Go toHome > PeopleTools > Security > User Profile > Copy User Profiles.

2. Select the user account you want to duplicate the list of values, for example, the PS user.

The Copy User profiles page for PS displays.

3. Enter the following information:

Field Description

New User ID Enter the name you want to assign to the new user account. For
example, PS_AA.

Description Archive access account for PS.

New Password Enter a password for the user account.

Confirm Password Enter the password again.

4. Click Save.

5. The user Profile pages for PS_AA displays.
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6. Select the new Symbolic ID from the list of values.

7. Click Save.

Enable archive access
Before you can view the archived data in PeopleSoft, you need to enable archive access.

1. Follow your company's procedures to create a new application server for archive access.

The user ID used when starting the application server must have its Symbolic ID pointing to the archive
access schema. For example, PS_AA should point to SYSADMAA.

2. Ensure that each user requiring archive access has an archive user profile.

Next steps
Continue with Next steps, on page 26.
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Chapter 5: Next steps
Running PeopleSoft business flows requires that you perform the following tasks:

1. Deploy business flows.

Before you can configure or run business flows, you need to deploy them into the environment.
You can deploy business flows from Designer or from theWebConsole.

2. Run business flows.

You use business flows to execute your archive logic. All deployed business flows configured to
run in an environment are displayed in theWebConsole.

3. Optionally, if you should ever need to remove a business flow, you are able to do so. You can use
theWebConsole to uninstall business flows. By default, the job run history is left intact.

SeeStructured DataManager RuntimeGuide
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Appendix A: Configure Tuxedo and
WebLogic for archive access
The following example is for configuring Oracle Tuxedo andWebLogic on UNIX to enable archive
access using PeopleSoft Internet Architecture (PIA).

l Create a new Tuxedo application server domain, below

l Create a new PeopleSoft web site on aWebLogic server, on page 30

l Start theWebLogic web server domain, on page 32

Create a new Tuxedo application server domain
1. Start the PeopleSoft Server Administrationmenu on the application server.

Example

cd $PS_HOME/appserv
./psadmin

2. Enter 1 to enter the PeopleSoft Application Server Administrationmenu.

3. Enter 2 to create a domain.

4. Enter the domain name you want to use at the prompt.

Example

Please enter name of domain to create :AAPSFS

NOTE:  Domain names are case-sensitive andmust be eight US-ASCII characters or
less. The domain name is used to create a directory name under the $PS_HOME/appserv
directory.

5. Enter 1 to use the small configuration template.

The domain is created and the following prompt displays:

Would you like to configure this domain now? (y/n) [y] :

Structured DataManager (2019.09) Page 27 of 42



6. Enter y to start the PeopleSoft Application Server Administration Quick-configuremenu.

Example

----------------------------------------------
Quick-configure menu -- domain: AAPSFS
----------------------------------------------
     Features                        Settings
    ==========                      ==========
1) Pub/Sub Servers    : No      15) DBNAME :[PSHRDMO]
2) Quick Server       : No      16) DBTYPE :[ORACLE]
3) Query Servers      : No      17) UserId :[PS]
4) Jolt               : Yes     18) UserPswd :[PS]
5) Jolt Relay         : No      19) DomainID :[AAPSFS]
6) WSL                : Yes     20) AddToPATH :[/appl/oracle/10.2.0/bin]
7) PC Debugger        : No      21) ConnectID :[people]
8) Event Notification : No      22) ConnectPswd:[peop1e]
9) MCF Servers        : No      23) ServerName :[]
10) Perf Collator     : No      24) WSL Port :[7030]
11) Analytic Servers  : No      25) JSL Port :[9030]
12) Domains Gateway   : No      26) JRAD Port :[9130]

Actions
=========
13) Load config as shown
14) Custom configuration
h) Help for this menu
q) Return to previous menu

Enter selection (1-26, h, or q):

7. Enter 6 to configure theWSL to boot.

8. Enter 13 to load the configuration.

NOTE:  If you plan to install a real-time event notification (REN) server, consult your
PeopleSoft documentation for further instructions.

9. Enter q to return to the PeopleSoft Application Server Administrationmenu.

10. Enter 1 to administer the domain server.

The Tuxedo domain list displays.

11. Enter the number for the domain you want to reboot.

12. Enter 1 to boot the domain.

13. Enter 1 to perform a serial boot.

14. Enter q to exit themenus without stopping the application server domain.
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Create new Tuxedo Process Scheduler
1. Start the PeopleSoft Server Administrationmenu on the application server.

Example

cd $PS_HOME/appserv
./psadmin

2. Enter 2 to enter the PeopleSoft Process Scheduler Administrationmenu.

3. Enter 4 to create a Process Scheduler Server Configuration.

4. Enter the database name you want to use at the prompt.

Example

Please enter name of the database that the server will access: PRDSCM91

The following prompt displays:

Would you like to configure this Process Scheduler now? (y/n) [y] :
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5. Enter y to start the PeopleSoft Process Scheduler Administration Quick-configuremenu.

Example

------------------------------------------------------
Quick-configure menu--Scheduler for database: H1SCM91O
------------------------------------------------------
     Features                     Settings
    ==========                   ==========
1) Master Schdlr    : Yes     5) DBNAME :[PSHRDMO]
2) App Eng Server   : Yes     6) DBTYPE :[ORACLE]
                              7) PrcsServer :[PSNT]
                              8) UserId :[PS_AA]
                              9) UserPswd :[PS_AA]
                              10) ConnectID :[people]
                              11) ConnectPswd:[peop1e]
                              12) ServerName :[]
         13) Log/Output Dir :[%PS_SERVDIR%\log_output]
         14) SQRBIN :[D:\PS851\bin\sqr\ORA\binw]
         15) AddToPATH :[%WINDIR%;%WINDIR%\SYSTEM32]
         16) DBBIN :[D:\oracle\product\10.2.0\client_1\BIN]

Actions
=========
3) Load config as shown
4) Custom configuration
h) Help for this menu
q) Return to previous menu

Enter selection (1-16, h, or q):
HINT: Enter 5 to edit DBNAME, then 3 to load

6. Enter 3 to Load the config as shown.

7. Enter 1 to start a Process Scheduler server. This boots the process Scheduler server.

Create a new PeopleSoft web site on a WebLogic
server
After you have created and configured the new application server domain, you need to create a
PeopleSoft web site on theWebLogic server that can connect to the new domain.

1. Navigate to the following directory:

$PS_HOME/setup/mpinternet

2. Run the setup program for your operating system.

The PeopleSoft Internet Architecture installation wizard displays.
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3. Click Next.

4. Specify the root directory where PeopleSoft is installed. This is usually called the PS_HOME
directory.

5. Choose the BEAWebLogic Server.

6. Specify the root directory whereWebLogic is installed.

NOTE:  Ensure that you select the correct directory forWebLogic. If you enter the
incorrect path, the following error message displays: Detected web server version: no
choices available.

7. Enter the administrator login ID and password for the new domain to be created.

8. Select the Create New WebLogic Domain radio button.

9. Enter the domain name you created in Create a new Tuxedo application server domain, on page 27
and click Next.

10. Select the type of domain you want to create.

11. Enter a name for the PeopleSoft web site, for example, AAPSFS.

12. Enter the following information:

Field Description

AppServer Name The ServerName from the application server configuration file found
in Create a new Tuxedo application server domain, on page 27.

JSL Port The JSL Port from the application server configuration file found in
Create a new Tuxedo application server domain, on page 27.

HTTP Port The HTTP port used by the application server.

HTTPS Port The HTTPS port used by the application server.

Authentication Token
Domain: (optional)

Optional. The Authentication Token Domain you want to use for the
application server.

13. Enter the web profile name used to configure the PeopleSoft web site, and the User ID and
password used by the PIA servlets to log in to the application server to retrieve the profile.

14. Specify the root directory for the Report Repository, for example, psreports.

15. Verify your selections and click Install to begin the installation.

16. Click Finish to complete the installation.

The default installation directory is $PS_HOME/webserv/<domain_name>.

where <domain_name> is the name of the domain you created.
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Start the WebLogic web server domain
You can now start the web server from the new directory you created.

1. Navigate to the new web server directory:

Example

cd $PS_HOME/webserv/<domain_name>/bin

Where <domain_name> is the name of the domain you created.

2. Start the web server.

Example

./startPIA.sh

You can now connect to the application from a client browser.

Example

http://<machine_name>:<http_port>/<site_name>/signon.html

Where Is

machine_name Themachine name or the IP address where the application is running.

http_port The port number for the application.

site_name The name of the web site you created in Create a new PeopleSoft web
site on aWebLogic server, on page 30.
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Appendix B: Tune the archive access layer
To improve the performance of the archive access layer for data transparency (database to database),
Structured DataManager provides a number of parameters. By adding a logon trigger to the archive
access schema, you can set these parameters to tune performance in your environment.

NOTE:  You need to add the logon trigger to any archive access schema used to access the
combined data. If you only have one archive access schema, you would add it just to that
schema. If you usedmultiple archive access schemas to combine the data, then you would
need to add it to each of those schemas.

Example
You could add a logon trigger similar to this one to all of the archive access schemas from which you
are combining data:

CREATE or replace TRIGGER obtps_cust_logon AFTER logon ON sysadmaa.schema begin
    declare
        procedure execute_sql (p_sql_stmt in varchar2) is
        l_count number;
        l_c number;
        l_rc number;
    begin
        l_c := dbms_sql.open_cursor;
        dbms_sql.parse(l_c, p_sql_stmt, dbms_sql.native);
        l_rc := dbms_sql.execute(l_c);
        dbms_sql.close_cursor(l_c);
    end execute_sql;

    BEGIN
    execute_sql('ALTER SESSION SET "_PUSH_JOIN_PREDICATE"=TRUE');
    execute_sql('ALTER SESSION SET "_COMPLEX_VIEW_MERGING"=true');
    execute_sql('ALTER SESSION SET "_UNNEST_SUBQUERY"=FALSE');
    execute_sql('ALTER SESSION SET optimizer_index_cost_adj=100');
    execute_sql('ALTER SESSION SET optimizer_index_caching=0');
    execute_sql('ALTER SESSION SET "_index_join_enabled"=false');
    execute_sql('ALTER SESSION SET "_optimizer_push_pred_cost_based"=false');
    execute_sql('ALTER SESSION SET "_optimizer_cost_based_transformation"=on');
    execute_sql('ALTER SESSION SET "_push_join_union_view"=true');
    END;
end;
/
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Glossary
active database
The database from which you plan tomove or
copy data. Typically, this database is your
online transaction processing (OLTP) or
production database. In a two- or three-tiered
configuration, the active database resides on
tier one and is the source for datamovement
operations.

active environment
TheWebConsole views and acts upon only
one environment at a time, the active
environment. To switch the active environment,
you use the Change Active option in theWeb
Console.

activity
In Designer, a component of a business flow,
which is added by using the toolbar. For
example, you can add archive and reload
activities to your business flow. Note, activities
in a business flow are different from what you
see at runtime and therefore do not necessarily
map directly to what you see in theWeb
Console.

advanced selection
A method of data selection that discovers all of
the interrelated rows frommultiple tables and
conceptually places them in the same
application partition for archiving.

annotation
In Designer, a comment associated with the
project, or one of its objects or components.
These comments are collected and published in
a PDF file when you right click a project or
business flow and select Generate
Documentation.

application partitioning
The concept of partitioning related rows
together during data selection, regardless of
whether they are in one or more tables.
Application partitioning is unique to Structured
DataManager and contrasts with themore
common table partitioning offered by the

databasemanagement software, which only
groups related rows from one table.

archive data store
The location where the data is to be archived.
Can be a separate database, separate space
on the same database, or an XML file. In a two-
tiered configuration, the archive data store
resides on tier two and can be a database or
XML. In a three-tiered configuration, the archive
data store is a database on tier two and XML on
tier three, and is the target for datamovement
operations.

archive query server
The component that provides SQL access to
XML database archives.

Consolidated Archive
A managed, scalable repository that
consolidates electronic communications,
attachments, and files, and provides complete
control over corporate information assets,
facilitating compliance with internal corporate
governance policies and procedures as well as
externally mandated laws and regulations.

business flow
A series of activities, such as archive
operations and scripts, that run in sequence.
You build business flows in Designer.

business flow status
TheWebConsole shows the last run of each
business flow. The states are
Complete/Error/Running.

cartridge
An instance of model- or schema-based
eligibility criteria used tomove or copy data
from one location to another. Cartridges capture
the application and business rules to ensure
referential integrity of the data. For any one
model in your project, youmay havemany
cartridges that use it.

chaining table
The lower level table in amany-to-one or a
many-to-many relationship between higher
level and lower level tables in themodel
hierarchy.
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classification
The Content Manager (formerly Records
Manager) classification to be applied to the data
moved by Structured DataManager. This
classification specifies where to place the data
when it is ingested by Content Manager. For more
information, see the Content Manager
documentation.

collection
The configuration of a directory location and file
pattern tomatch a set of archived XML files,
thus allowing SQL access to the archived data.

comma separated values (CSV)
A database-to-file output format that stores the
data as values separated by commas and a
metadata file. Each line in the CSV file
corresponds to a row in a table. Within a line,
fields are separated by commas, each field
belonging to one table column. CSV files
provide a simple format that many applications
can import.

command
Command files or JavaScript files launched by
theWebConsole on your behalf with status
displays.

condition
In Designer, the way you branch your business
flow to run or skip an activity based on some
criteria.

configuration parameter
A type of parameter that has its values set by
an administrator (someone who has repository
privileges from theWebConsole) through the
administrator interface. Typically, this type of
parameter represents values that should be
changed very infrequently, perhaps only at
deployment time.

console user
TheWebConsole identifies individual users,
who are distinct from database users. The
properties for a user are User Name, Full
Name, Password, Enabled, Description, Email,
Phone, and Privileges.

console user name
The login name associated with aWebConsole
user.

constraint
A column or a list of columns that enables you
to identify rows in the database and relate them
to one another.

Content Manager
Enterprise document and records management
software designed to simplify the capture,
management, security, and access to
information. Records Manager enables
organizations tomore easily comply with
regulations and corporate policies, and it helps
secure information from inappropriate access
andmisuse.

custom properties
User-created name/value pairs in cartridges
and business flows. These values are exposed
at runtime as parameters.

customization
A change that an administrator or DBA makes
to a project provided by a third party, typically
for a packaged application like Oracle
PeopleSoft or Oracle E-Business Suite. As
long as the customization is allowable by the
project, the user canmerge the customization
into newer revisions of the third party project.

customization mode
A Designer mode that provides visual cues to
indicate customizations in themodel. In a
project with locked files, customizationmode is
on by default, but you can toggle it on and off
from the toolbar in themodel editor.

data access cartridge
A cartridge that provides lightweight query
access to retired or archived data. Data access
cartridges are designed by the archive
developer but can be run by business users
with no technical expertise.

data masking
The process of replacing private or confidential
data duringmovement with a specifiedmask.
You can choose from pre-definedmasks that
are part of Micro Focus or create your own
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mask. A mask may or may not be reversible
upon reload from the archive data store.

data movement
Themethod used by Structured DataManager
to actually move data (transactional, bulk or
partitioned for database to database, and copy
or archive for database to file).

data transparency
The ability to access archived data through
your standard application interfaces for data
access. Data transparency enables users to
access archived data as though it were still in
the active database.

database constraint
A constraint that exists in the database and can
be discovered and referenced from Designer.

database to database
A movement in which data goes from an active
database to an archive database, or separate
tablespaces inside the active database.
Typically, the archive database is located on
cheaper storage devices.

database to file
A movement in which data goes from an active
database to a file (XML, JSON or CSV format),
which is offline but still accessible through SQL
using the archive query server and a client tool
of your choice.

deployment assistant
The user interface component within Designer
used to deploy or generate business flows.

description
A technical description created by the
developer for her own reference. These
descriptions do not appear in the generated
PDF file for the cartridge or business flow.

Designer
The user interface component used to develop,
test, and deploy your archiving solution.
Designer is a powerful graphical development
environment for archive solutions.

distributed instance
A configuration option for database-to-database
archiving where the data you archive is stored

on a separate database from the source or
active database.

DRE
SeeDynamic Reasoning Engine (DRE).

driving table
A driving object is a root of amodel hierarchy.
Its relationship to the child tables drives the
selection of transactions.

dynamic list of values
A list of values for a parameter that obtains its
members from a SELECT statement that
returns identifiers and labels.

dynamic parameter
A type of parameter that has its value set by a
Groovy script that runs at deployment time to
obtain a value. For example, this type of
parameter can supply the type or version of a
database or application, which can be obtained
programmatically at deployment time.

Dynamic Reasoning Engine (DRE)
A platform technology that uses high
performance pattern-matching algorithms to
search for content stored inMicro Focus
repositories. Performs core information
operations for contextual analysis and concept
extraction, enabling solutions for the
categorization, summarization, personalization,
hyperlinking, and retrieval of all forms of
information.

environment
The source and (optional) target credentials
against which you plan to run commands. You
can definemultiple environments within your
installation to identify various source and target
databases.

error
One of the ways in which you can interrupt a
business flow. Error indicates that the business
flow failed for some reason.

exclusive rules
One of the ways in which Structured Data
Manager determines whether to include or
exclude rows from the archive operation.
Exclusive rules require all rows in the constraint
table to match for inclusion. Exclusive rules
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exclude the instance if the condition on any
child is false, like STATUS=’CLOSED’.

exit
One of the ways in which you can interrupt a
business flow. You can exit successfully or
with a warning.

export
The way that you save an Structured Data
Manager project to an exchange format (.hdp)
from the File menu. See also import.

export data
The way that a user can send data to CSV
format from Preview using the toolbar item.

generate documentation
The process of collecting and grouping all
annotations into a PDF file that also describes
the business flow or cartridge structure.

history schema
For database-to-database archiving, the
schema in the target database where the
archived data is stored.

IDOL
See Intelligent Data Operating Layer (IDOL).

import
The way that you transfer projects from
exchange format (.hdp) into the Project
Navigator. You can also use import to migrate
cartridges created in 5.1 to 6.x. See also
export.

inclusive rules
One of the ways in which Structured Data
Manager determines whether to include or
exclude rows from the archive operation.
Inclusive rules require only one row in the
constraint table to match the rule and be
included. Inclusive rules include the instance if
the condition on any child is true, like
PRODUCT_RECALLED=’Y’.

indexing cartridge
A cartridge that indexes your data for better
searching. For example, youmight associate
an indexing cartridge with a database-to-file
archiving cartridge to improve performance
when querying the archive data files.

Intelligent Data Operating Layer (IDOL)
An information processing layer that collects
indexed data from connectors and stores it in a
structure optimized for fast processing and
retrieval, integrating unstructured, semi-
structured, and structured information from
multiple repositories.

interrupt
The way to stop or pause a business flow
(pause, error, exit with warning, exit
successfully).

local deployment
The generation and deployment of your
cartridge or business flow to an environment on
your local, Designer client. Deployment files
are generated locally and then deployed to the
designated, local environment.

lookup table
A table that contains helpful non-transactional
information. For example, non-transactional
information could be status definitions, or the
name of the sales representative.

managed table
A table in themodel that is copied and then
purged from the active database by a cartridge.
Transactional, chaining, and driving tables in a
model are all typically managed tables.

model
A model identifies the tables and table
relationships representing a business entity or
related business entities. A project can have
multiple models. Eachmodel contains a driving
table and all of its child and descendent tables.

model compatibility
Eachmodel in your project can have one or
more dynamic parameters associated with it to
verify the compatibility with the target
environment. If the compatibility parameter
returns false, then the cartridge referencing the
model will not deploy or run and throw an error.
For example, the script could return false for
Oracle 10.2 and true for Oracle 11.1 to indicate
that a cartridge referencing themodel can only
deploy and run against Oracle 11.1.
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model-based cartridge
A cartridge that moves data based upon a
defined datamodel with relationships. This type
of cartridge is typically used for ongoing archive
operations.

non-intrusive environment
In a non-intrusive environment, data is archived
without an interface schema and a generic
JDBC driver is used. A non-intrusive
environment enables you to copy or archive
data from read-only sources, which is
especially helpful in cases where the data is
associated with older technologies that might
not support basic SQL statements or when the
database administrator or company policy
prohibits write access to the production
environment.

OLTP database
The online transaction processing database
that typically is your active or source database.

pause
One of the ways in which you can interrupt a
business flow. Pausing suspends the business
flow while awaiting operator intervention.

reload
The act of taking data from an archive data
store and loading it into the active database.

remote deployment
The generation and deployment of your
cartridge or business flow to an environment on
a system that is remote from your Designer
client. Deployment files are generated locally
and then deployed to the designated, remote
environment.

repository
The location that holds business flow
metadata, product configuration data, and data
collected during runtime. The repository can be
located on your active database or another
logical database.

rule
Qualifications added to themodel in order to
include or exclude data based on certain
criteria. For example, youmight add a rule to

exclude from archiving any orders that are not
yet closed.

runtime parameter
A type of parameter that has its values set by
the operator executing the job in Console or on
the command line. Typically, this type of
parameter represents operational values that
tend to change frequently and therefore need to
be set each time the job is run.

schema-based cartridge
A cartridge that moves data based upon the
database schema rather than a defined data
model with relationships. This type of cartridge
is typically used for database retirement or the
cleanup of orphan tables.

selection
The form of data selection to use (standard or
advanced) for choosing data. When deploying a
cartridge or adding it to a business flow, you
must specify the selectionmethod.

single instance
A configuration option for database-to-database
archiving where the data you archive is stored
on the same database (Oracle) or the same
server (SQL Server) as the source or active
database.

source
The location (database) from which you are
copying or moving data.

SQL access server
See archive query server.

standard selection
A method of data selection that restricts itself
to the rows identified by themodel. Unlike
advanced selection, it does not attempt to
traverse related rows across multiple tables.

structured records management
A type of solution that extracts structured data
from a source application andmoves it into
XML format. The XML is then ingested into the
corporate records management system for long
termmanagement and eventual disposal
according to corporate policy.
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table use
A database table, view, or synonym that is
referenced in Designer, for example, in the
model. The same table can be usedmultiple
times in amodel. For example, a table could be
appear as a transactional table and a lookup
table in the samemodel.

target
The location (database or XML) to which you
are copying or moving data.

tier
A level in your database archiving
configuration. You can have two- or three-tiered
configurations. In a two-tiered configuration, tier
one contains your active database and tier two
your archive data store, which can be a
database or XML. In a three-tiered
configuration, tier one contains your active
database, tier two an archive database, and tier
three XML.

transactional data movement
Transactional movement uses set-based data
movement and is the default method of
movement.

transactional table
A table that contains information about the
business transaction. For example, a
transactional table might contain detailed tax or
payment information related to each business
transaction.

unique identifiers (UIDs)
A 16 hexadecimal identifier calculated based on
the content of a Designer file. This value is
used to determine if the user has customized
key pieces of a project.

unmanaged table
A table in amodel that is copied but not purged
from the active database by a cartridge. Lookup
tables in amodel are typically unmanaged
tables.

Vertica
Column-oriented SQL databasemanagement
software for storing and analyzing structured
data. Used tomanage large, fast-growing
volumes of data and provide fast query

performance for data warehouses and other
query-intensive applications.

virtual constraint
A constraint that you define in Designer that
only exists within Structured DataManager.

Web Console
A browser-based interface where you can
create andmanage your deployment
environments, and deploy, run, administer, and
monitor your business flows.
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Send documentation feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on PeopleSoft Modules Installation and Deployment Guide (Micro Focus Structured
Data Manager 2019.09)

Add your feedback to the email and click Send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to swpdl.sdm.docfeedback@microfocus.com.

We appreciate your feedback!
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